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After Vegas® Movie Studio™ software is installed and you start it for the first time, the 
registration wizard appears. This wizard offers easy steps that allow you to register the 
software online with Sony Creative Software Inc. 

Registering your product will provide you with access to a variety of technical support 
options, notification of product updates, and special promotions exclusive to 
registered Vegas Movie Studio users. 

Registration assistance 

If you do not have access to the Internet, registration assistance is available during 
normal weekday business hours. Please contact our Customer Service department by 
dialing one of the following numbers: 

Telephone/Fax Country

1-800-577-6642 (toll-free) US, Canada, and Virgin Islands


+608-204-7703 for all other countries


1-608-250-1745 (Fax) All countries


Customer service/sales 

For a detailed list of customer service options, we encourage you to visit 
http://www.sonycreativesoftware.com/support/custserv.asp. Use the following 
numbers for telephone support during normal weekday business hours: 

Telephone/Fax Country

1-800-577-6642 (toll-free) US, Canada, and Virgin Islands


+608-204-7703 for all other countries


1-608-250-1745 (Fax) All countries


Technical support 

For a detailed list of technical support options, we encourage you to visit 
http://www.sonycreativesoftware.com/support/default.asp. To listen to your support 
options by telephone, please call 608-256-5555. 

About your rights in Vegas Movie Studio software 

Vegas Movie Studio software is licensed to you under the terms of the End User License 
Agreement. The End User License Agreement is first presented to you when you install 
the software. Please review the End User License Agreement carefully as its terms affect 
your rights with respect to the software. For your reference, a copy of the End User 
License Agreement for Vegas Movie Studio software is located at 
http://www.sonycreativesoftware.com/. 

http://mediasoftware.sonypictures.com/support/custserv.asp
http://mediasoftware.sonypictures.com/support/default.asp
http://www.sony.com/mediasoftware
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About your privacy 

Sony Creative Software Inc. respects your privacy and is committed to protecting 
personal information. Your use of the software is governed by the Software Privacy 
Policy. A copy of this policy is incorporated into the registration process and you are 
asked to agree to its terms prior to accepting the terms of the End User License 
Agreement. Please review its contents carefully as its terms and conditions affect your 
rights with respect to the information that is collected by the software. For your 
reference, a copy of the Software Privacy Policy is located at http:// 
www.sonycreativesoftware.com/corporate/privacy.asp. 

Proper use of software 

Vegas Movie Studio software is not intended and should not be used for illegal or 
infringing purposes, such as the illegal copying or sharing of copyrighted materials. 
Using Vegas Movie Studio software for such purposes is, among other things, against 
United States and international copyright laws and contrary to the terms and 
conditions of the End User License Agreement. Such activity may be punishable by law 
and may also subject you to the breach remedies set forth in the End User License 
Agreement. 

Legal notices 

ACID, ACIDized, ACIDplanet.com, ACIDplanet, the ACIDplanet logo, ACID XMC, Artist Integrated, the Artist 
Integrated logo, Beatmapper, Cinescore, CD Architect, DVD Architect, Jam Trax, Perfect Clarity Audio, Photo 
Go, Sound Forge, Super Duper Music Looper, Vegas, Vision Series, and Visual Creation Studio are the 
trademarks or registered trademarks of Sony Creative Software Inc. in the United States and other 
countries. All other trademarks or registered trademarks are the property of their respective owners in the 
United States and other countries. 

PlayStation and PSP are registered trademarks of Sony Corporation Entertainment Inc. 
Apple Macintosh Audio Interchange File Format (AIFF) file format 

Apple® Macintosh® Audio Interchange™ File Format (AIFF) is a trademark of Apple, Inc. in the United States 
and other countries. 
Apple QuickTime 

Apple® QuickTime® application is a trademark of Apple, Inc. in the United States and other countries. 
ATRAC 

“ATRAC,” “ATRAC3,” “ATRAC3plus,” “ATRAC Advanced Lossless,” and the ATRAC logo are trademarks of Sony 
Corporation. 

http://www.sony.net/Products/ATRAC3/ 
AVCHD 

AVCHD and AVCHD logo are trademarks of Matsushita Electric Industrial Co., Ltd and Sony Corporation. 
Dolby, Dolby Digital AC-3, and AAC encoding 

This product contains one or more programs protected under international and U.S. copyright laws as 
unpublished works. They are confidential and proprietary to Dolby Laboratories. Their reproduction or 
disclosure, in whole or in part, or the production of derivative works therefrom without the express 
permission of Dolby Laboratories is prohibited. Copyright 1992 – 2008 Dolby Laboratories. All rights 
reserved. 

Dolby®, the double-D symbol, AC-3®, and Dolby Digital® are registered trademarks of Dolby Laboratories. 
AAC™ is a trademark of Dolby Laboratories. 

http://mediasoftware.sonypictures.com/corporate/privacy.asp
http://mediasoftware.sonypictures.com/corporate/privacy.asp
http://www.sony.net/Products/ATRAC3/
http:ACIDplanet.com
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FLAC/Ogg File Formats 

©2008, Xiph.org Foundation 

Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission. 

This software is provided by the copyright holders and contributors “as is” and any express or implied 
warranties, including, but not limited to, the implied warranties of merchantability and fitness for a 
particular purpose are disclaimed. In no event shall the foundation or contributors be liable for any direct, 
indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, 
procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however 
caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or 
otherwise) arising in any way out of the use of this software, even if advised of the possibility of such 
damage. 
Gracenote 

CD and music-related data from Gracenote, Inc., copyright © 2000-2008 Gracenote. Gracenote Software, 
copyright 2000-2008 Gracenote. This product and service may practice one or more of the following U.S. 
Patents: #5,987,525; #6,061,680; #6,154,773, #6,161,132, #6,230,192, #6,230,207, #6,240,459, #6,330,593, 
and other patents issued or pending. Services supplied and/or device manufactured under license for 
following Open Globe, Inc. United States Patent 6,304,523. 

Gracenote and CDDB are registered trademarks of Gracenote. The Gracenote logo and logotype, MusicID, 
and the “Powered by Gracenote” logo are trademarks of Gracenote. 
i.LINK 

i.LINK® is a registered trademark of Sony Electronics, used only to designate that a product contains an IEEE 
1394 connector. All products with an IEEE 1394 connector may not communicate with each other. 
JPEG 

This software is based in part on the work of the Independent JPEG Group. 
LPEC 

“LPEC” is a trademark of Sony Corporation. 
Macromedia Flash 

Macromedia and Flash are trademarks or registered trademarks of Macromedia, Inc. in the United States 
and/or other countries. 
Main Concept encoder 

Main Concept® plug-in is a trademark of registered trademark of Main Concept, Inc. in the United States or 
other countries. All rights reserved. 
Microsoft DirectX programming interface 

Portions utilize Microsoft® DirectX® technologies. Copyright © 1999 – 2008 Microsoft Corporation. All rights 
reserved. 
Microsoft Windows Media Technologies 

Portions utilize Microsoft Windows Media Technologies. Copyright © 2008 Microsoft Corporation. All rights 
reserved. 
MPEGLA and MPEG 2 

USE OF THIS PRODUCT IN ANY MANNER THAT COMPLIES WITH THE MPEG-2 STANDARD IS EXPRESSLY 
PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, 
WHICH LICENSE IS AVAILABLE FROM MPEG-LA, LLC, 250 STEELE STREET, SUITE 300, DENVER, COLORADO 
80206. 

Manufactured under license from MPEG-LA. 
PNG file format 

Copyright © 2008. World Wide Web Consortium (Massachusetts Institute of Technology, European 
Research Consortium for Informatics and Mathematics, Keio University). All rights reserved. This work is 
distributed under the W3C Software License in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTIBILITY or FITNESS FOR A PARTICULAR 
PURPOSE. http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231. 

http://xiph.org/
http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231
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Real, RealMedia, RealAudio, and RealVideo applications 

2008 RealNetworks, Inc. Patents Pending. All rights reserved. Real®, Real Media®, RealAudio®, RealVideo®, 
and the Real logo are trademarks or registered trademarks of RealNetworks, Inc. in the United States and 
other countries. 
Sony AVC/AAC 

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL AND NON­
COMMERCIAL USE OF A CONSUMER TO (i)ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii)DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://MPEGLA.COM 
Steinberg Media Technologies 

VST® is a registered trademarks of Steinberg Media Technologies GmbH. 

ASIO™ is a trademark of Steinberg Media Technologies GmbH. 
Tagged Image File Format (TIFF) 

Adobe Tagged Image™ File Format is a registered trademark of Adobe Systems Incorporated in the United 
States and other countries. All rights reserved. 
Targa file format 

The Targa™ file format is a trademark of Pinnacle Systems, Inc. 
Thomson Fraunhofer MP3 

MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. 

Supply of this product does not convey a license nor imply any right to distribute content created with this 
product in revenue generating broadcast systems (terrestrial, satellite, cable and/or other distribution 
channels), streaming applications (via internet, intranets and/or other networks), other content 
distribution systems (pay-audio or audio on demand applications and the like) or on physical media 
(compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards and the like). 

An independent license for such use is required. For details, please visit: http://mp3licensing.com. 
Thomson Fraunhofer MPEG-4 HE-AAC 

MPEG-4 HE-AAC audio coding technology licensed by Fraunhofer IIS. For details, please visit: http:// 
www.iis.fraunhofer.de/amm/. 

Sony Creative Software Inc. 
1617 Sherman Avenue 
Madison, WI 53704 
USA 

The information contained in this manual is subject to change without notice and does 

not represent a guarantee or commitment on behalf of Sony Creative Software Inc. in 

any way. All updates or additional information relating to the contents of this manual

will be posted on the Sony Creative Software Inc. web site, located at http://

www.sonycreativesoftware.com/. The software is provided to you under the terms of 

the End User License Agreement and Software Privacy Policy, and must be used and/or 

copied in accordance therewith. Copying or distributing the software except as

expressly described in the End User License Agreement is strictly prohibited. No part of 

this manual may be reproduced or transmitted in any form or for any purpose without 

the express written consent of Sony Creative Software Inc.


Copyright 2008. Sony Creative Software Inc.


Program Copyright 2008. Sony Creative Software Inc. All rights reserved.


http://mp3licensing.com
http://www.iis.fraunhofer.de/amm/
http://www.iis.fraunhofer.de/amm/
http://www.sony.com/mediasoftware
http://www.sony.com/mediasoftware
HTTP://MPEGLA.COM
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Chapter 1
 Introduction  

Welcome 

Vegas® Movie Studio™ software from Sony Creative Software Inc. is an 
innovative and advanced multitrack media-editing system. This software 
was designed to create an efficient audio/video production environment 
without sacrificing the quality and processing power that you expect from 
Sony Creative Software Inc. Whether it’s the standard and familiar 
Microsoft® Windows® navigation commands or the clean and uncluttered 
interface, you’ll find Vegas Movie Studio software a pleasure to use. 

System requirements 

In order to use Vegas Movie Studio software, your computer must satisfy 
the following minimum specifications: 

•	 Microsoft® Windows® XP SP2 or Windows Vista™ 

•	 800 MHz processor (2.8 GHz recommended for HDV or AVCHD in Vegas 
Movie Studio Platinum) 

•	 200 MB hard-disk space for program installation 

•	 256 MB RAM (512 MB RAM recommended for HDV or AVCHD in Vegas 
Movie Studio Platinum) 

•	 OHCI-compatible i.LINK® connector*/IEEE-1394DV card (for DV capture 
and print-to-tape) 

•	 Windows-compatible sound card 

•	 DVD-ROM drive (for installation from a DVD only) 

•	 Supported CD-recordable drive (for CD burning only) 

•	 Supported DVD- R/-RW/+R /+RW drive (for DVD burning only) 

•	 Supported BD-R/-RE drive (for Blu-ray Disc™ burning only) 

•	 Microsoft DirectX® 9.0c or later 

•	 Microsoft .NET Framework 2.0 (included on application disc) 

Note: You must provide your registration information to Sony Creative 
Software Inc. to activate the software. 

*i.LINK is a registered trademark of Sony Electronics, used only to designate 
that a product contains an IEEE 1394 connector. All products with an IEEE 
1394 connector may not communicate with each other. 
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Technical support 

The Web site at http://www.sonycreativesoftware.com/support/default.asp has 
technical support, reference information, program updates, tips and tricks, user forums, 
and a knowledge base. 

Installing Vegas Movie Studio software 

1.	 Insert the DVD-ROM. The setup screen appears (if DVD-ROM AutoPlay is enabled). 

If DVD-ROM AutoPlay is not enabled, click the Start button and choose Run. In the 
Run dialog that appears, type the DVD-ROM drive’s letter and add :\setup.exe. Click 
OK to start the installation. 

2.	 Click Install. The installation process begins. 

3.	 Follow the on-screen prompts to install the appropriate version of the software for 
your computer. 

Using this manual 

This manual is provided to assist users of Vegas Movie Studio and Vegas Movie Studio 
Platinum software applications. For this reason, product features are identified 
throughout the manual using the following icon: 

Features exclusive to Vegas Movie Studio Platinum 

Getting help 

This Quick Start Manual is intended to help you learn the basic skills you need to create 
a Vegas Movie Studio project. If you need more assistance, we provide two varieties of 
help in the application. 

Online help 

Choose Contents and Index from the Help menu or press F1. The online help window 
has four tabs that you can use to find the information you need. 
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Tabs 
Toolbar 

Information 
pane 

Show Me How tutorials 

You can learn more about many of the features in Vegas Movie Studio and Vegas Movie 
Studio Platinum by using the interactive Show Me How tutorials installed with the 
software. 

By default, Show Me How tutorials appear upon startup of the application. However, 
you can access them at any time from the Help menu by choosing Show Me How. 

Help on the Web 

Additional help and information is available on the Sony Creative Software Web site. 
From the Help menu, choose Sony on the Web to view a listing of Web pages 
pertaining to Vegas Movie Studio software and Sony Creative Software Inc. 

Overview 

The following sections provide a graphical tour of the Vegas Movie Studio workspace. 
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Main window 

The main window appears when you open the software. The work area is divided into 
three primary areas: the track list, the track view (or timeline), and the window docking 
area. You can resize the track list, track view, and window docking area by dragging the 
dividers between them. 
Menu bar 

Transport bar 

Marker bar Toolbar 

Time Ruler 
display 

Track view Track 
(timeline)list 

Scrub 
control 

Window 
docking 
area 

Status bar 

Toolbar 

The toolbar allows you to quickly access the most commonly used functions and 
features. From the Options menu, choose Customize Toolbar to specify which buttons 
are displayed.


Create new project 

Open existing project 

Save project 

Open project properties 

Publish project to the Web 

Cut selected events or time 
range 

Copy selected events or time 
range 

Paste items from clipboard 
into project 

Undo 

Enable automatic crossfades 

Enable automatic ripple 
editing 

Lock envelopes to events 

Ignore event grouping 

Normal edit tool 

Envelope edit tool 

Selection edit tool 

Zoom edit tool 

Make Movie Wizard 
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Create new project Enable automatic crossfades 

Redo Show Me How tutorials 

Enable snapping to grid lines What’s This Help 

Time display 

The Time Display window reflects the cursor’s position on the timeline and the end 
point of a time selection. You can customize time display settings, including what time 
the window displays and which colors are used in the display. 

You can move the Time Display window from its docked position above the track list to 
float on the workspace or dock in the window docking area. 
Docked position Floating window Docked in window docking area 

Ruler 

The ruler is the timeline for your project. You may specify how the ruler measures time: 
seconds, measures and beats, frames, etc. 

Marker bar 

The marker bar is the area where you can place, name, and position markers and 
regions along the project’s timeline. These informational tags can serve as cues or 
reminders highlighting important events in your project. 

Command bar 

The command bar is displayed when you add a command to your project. Commands 
add metadata to media files to create effects such as closed captioning. For more 
information, see Adding project markers and regions on page 46. 
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CD layout bar 

The CD layout bar is displayed for tracks and indexes in an audio CD layout project for 
disc-at-once (DAO) CD burning. 

Track list 

This area identifies the track order in your project and contains controls used to 
determine track compositing and mixing. For more information, see Using the track list 
on page 27. 

Track 
minimize and 

Selected 

Video tracks 

Parent/ 
child 

Track number 
Audio track 

Timeline 

All arranging and editing is done in the timeline or track view. This area contains all of a 
project’s events. For more information, see Using the track view on page 26. 

Transport bar controls 

The transport bar contains the playback and cursor positioning buttons frequently 
used while working on and previewing your project. 

Record into track Pause project playback 

Loop playback Stop playback 

Play from beginning of project Move cursor to start of 
project 
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Record into track Pause project playback 

Play project from cursor Move cursor to end of 
position project 

Status bar 

The status bar is located at the bottom of the main program 
window and displays information about roughly how much 
space is left on your computer to record audio (Record Time). 
During the rendering processes, the left side of the status bar also contains information 
about the progress of the render. 

The Video Preview window also has its own status bar that displays project specific 
information. For more information, see Playing your project on page 29. 

Scrub control 

The scrub control is used to play your 
project forward or backward for editing 
purposes. You may adjust playback speed 
by setting the speed control marker 
located beneath the scrub control. For 
more information, see Scrubbing on page 30. 

Window docking area and floating window docks 

This area allows you to keep frequently used windows available but out of the way. 
Windows can be docked next to each other, in a stack in the window docking area, or in 
a separate floating docking window. When stacked, each window has a tab at the 
bottom with its name on it. Click the window’s tab to bring it to the top. 

Drag either 
forward or 
backward for 
playback Set playback speed 

Drag the handle away 
from the docking area to 
float the window. 

Close window 
Expand window 

•	 To dock a window, drag it to the docking area. 

•	 To remove a window from the docking area and float it, drag the handle on the left 
side of a docked window. 

•	 To prevent a window from docking when you drag it, hold the Ctrl key. 
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•	 To expand a docked window so it fills the docking area, click the Maximize button 
( ). Click again to restore the window to its previous size. 

•	 To remove a window from the docking area or a floating dock, click the Close 
button ( ). 

Explorer window - Alt+1 

The Explorer window is similar to the Microsoft Windows Explorer. Use the Explorer 
window to select media files to drag to the project timeline or add to the Project Media 
list. You can also use the Explorer to perform common file management tasks such as 
creating folders, renaming files and folders, deleting files and folders. Use the Start 
Preview ( ) and  Auto Preview ( ) buttons to preview files before adding them to 
the project. 

Preview selected 
Select 

media files before 
drive or 

placing them in the 
folder 

project. 

Select media to place in 
the project by dragging 
and dropping or 
double-clicking. 

Trimmer window - Alt+2 

The Trimmer window is a good place to edit any media file. When a media file is placed 
in the Trimmer window, you can place portions of the file on separate tracks by 
dragging and dropping. 
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Mixer window - Alt+3 

The Mixer window gives you access to your project’s audio properties and output 
levels. 

Video Preview window - Alt+4 

The Video Preview window displays a project’s video during project editing and 
playback. For more information, see Playing your project on page 29. 

Video appears during 
project playback or 
as the cursor is 
moved during 
editing. 

Right-click to change 
Video Preview 
settings. 

Project Media window - Alt+5 

The Project Media window helps you organize the media files you’re using in a project. 
The information about these files is displayed in a highly flexible database that can be 
instantly sorted. You can also use the Project Media window to apply effects and plug-
ins to media files and set the specific properties of these files. For more information, see 
Using the Project Media window on page 17. 
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Transitions window - Alt+7 

The Transitions window contains all of the effects you can use to transition between 
video clips. The thumbnails display animated examples of each transition. You can drag 
transitions from this window to replace the crossfade between two video events or to 
replace the fade-in or fade-out region of a video event. 

Video FX window - Alt+8 

The Video FX window contains the video effects available. The thumbnails display 
animated examples of each plug-in preset. You can drag plug-ins from this window to 
an event, track, or to the Video Preview window (video output effects). 

Media Generators window - Alt+9 

The Media Generators window contains the different media generators provided. 
Media generators make it easy to create events containing text, credit rolls, test 
patterns, color gradients, and solid color backgrounds. You can drag a media generator 
to the timeline to create a new generated media event. 
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Chapter 2
 Getting Started  

Vegas® Movie Studio™ software is a new way of creating multimedia 
productions. Whether you are an experienced multimedia author or a 
budding novice, the powerful features and capabilities of Vegas Movie 
Studio software are organized to increase your creativity and productivity. 
The following chapter summarizes the software’s basic functions and 
operations. 

Creating projects 

The process of creating a multimedia production can be a complicated 
undertaking, involving hundreds of shots, takes, voiceovers, music beds, 
audio tracks, and special effects. Organization is a critical issue in this 
process. In the software, organization is handled by a small project file (.vf ) 
that saves information about source file locations, edits, cuts, insertion 
points, transitions, and special effects. This project file is not a multimedia 
file, but is instead used to create (render) the final file when editing is 
finished. 

Because Vegas Movie Studio software edits a project file and not the original 
source files, you can edit without worrying about corrupting your source 
files. This not only gives you a strong sense of security, but it also gives you 
the freedom to experiment. 

1.	 From the Project menu, choose New. The New Project Wizard appears. 

2.	 Set your project 
name and the 
location where you 
want to save it: 

a.	 Type a name to

identify your 

project.


b.	 Browse to the

folder where 

you want to

store new media 

files.


3.	 Click Next. The 
Video Standard page appears. 

4.	 Select the region where you video will be shown: Americas and Japan 
or Europe and Asia. 

5.	 Click Next. The Delivery Format page appears. 

•	 Choose a video output setting from the Output type drop-down list 
and click Next. The audio format page appears. 

The first page of the New Project Wizard. 
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•	 If you are unsure of the final destination of your project, select the I’m not sure 
yet; I will choose later radio button and click Next. The Audio Format page 
appears. 

6.	 Specify the audio format for your project, stereo or 5.1 surround, and click Next. 
The Done page appears.

 5.1-surround audio is available only in Vegas Movie Studio Platinum.


7.	 Click Finish to start working with your project. 

Saving a project 

When you save your work, it is saved in a project file. Project files are not rendered 
media files. To save a project, choose Save from the Project menu, or press Ctrl+S. 

Renaming a project (using Save As) 

After you have been working with your project, you can use the Save As command in 
the Project menu to save a copy of a project with a new name. This is useful for backing 
up different versions of a project. 

Tip: Select the Copy and trim media with project check box to save the project file 

and copies of the media files to a common location.


Getting media files 

You can add media from a variety of sources to your project. You can add audio and 
video files, record audio into a track, capture video from a video camera, or extract 
music from your own CD. You can also create media such as text overlays, 
backgrounds, and credit rolls from within the software. 

Note: When you add an ACID loop to the timeline, it is automatically stretched to 
match the project tempo as specified on the Ruler tab of the Project Properties dialog. If 
you want to ignore tempo information, clear the Import at project tempo check box on 
the Audio tab of the Preferences dialog. 
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Previewing a media file 

You may preview files before placing them in your project. The Explorer window has a 

mini-transport bar with Play, Stop, and Auto Preview buttons ( ). When you 
preview a file, its stream is sent to the Mixer window’s preview bus (for audio files) or to 
the Video Preview window (for video files). 

Tip: You can use the same mini-transport bar buttons in the Project Media window to 
preview files in the Project Media list. 

1. Select a file in the Explorer window.


2. Click the Play button ( ) to listen to the file. 

3. Click the Stop button ( ) or select a different file to stop previewing the file. 

Tip: To automatically preview selected files, click the Auto Preview button ( ) on 
the Explorer window’s transport bar. 

Using the Project Media window 

Media files, both video and audio, tend to be the 
largest files on your hard drive. It is therefore not 
always easy to move them around and impractical 
to store multiple copies of these files. You can add 
media files to the Project Media list to organize them 
before any editing begins. Once you begin working 
on a project, all files you add to the timeline are 
automatically included in the Project Media list. 
From the View menu, choose Project Media to open 
this window if it is not already visible. 

Using Project Media views 

You can control the information that is displayed in the Project Media window by 
clicking the Views button ( ) and selecting a view. 

For more on views, see the online help (from the Vegas Movie Studio Help menu and 
choose Contents and Index). 

Adding media to the Project Media list 

You can add media to the Project Media list without adding it to the timeline by 
importing the file. For more on importing files, see the online help (from the Vegas 
Movie Studio Help menu and choose Contents and Index). 
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Adding media to the Project Media list from the Explorer window 

1.	 Navigate to and select a file to add to the Project Media list. You can use Ctrl or Shift 
to select multiple media files. 

2.	 Right-click the file and choose Add to Project Media list from the shortcut menu. 
The selected file is added to the Project Media list. 

Replacing media in the Project Media list 

You may replace a file in the Project Media list with a different file. When changing the 
media file that an event contains, every occurrence of the event on the timeline is 
updated with the new media file contents. 

1.	 Right-click a file in the Project Media window. 

2.	 Choose Replace from the shortcut menu. 

3.	 In the Replace Media File dialog, browse for and select the file with which you want 
to replace the current file. 

4.	 Click Open. The selected file replaces the old file in the Project Media list, and any 
events in the timeline containing the old file are updated to contain the new media 
file. 

Capturing DV or HDV video 

You can use the Sony Video Capture application installed with Vegas Movie Studio 
software to capture video clips from your DV or HDV video camera and add them to the 
Project Media window. You can also specify a different third-party capture application 
for video capture.

 HDV video capture is available only in Vegas Movie Studio Platinum.


Tip: To specify the video capture application you want to use with the full version of 
Vegas software or in Vegas Movie Studio Platinum software, check the Use external 
video capture application check box on the Video tab of the Preferences window and 
browse for the program’s executable (.EXE) file. 

To specify the video capture application you want to use with Vegas Movie Studio 
Platinum software, browse for the program’s executable using the Browse button next 
to the Preferred video capture application box on the Video tab of the Preferences 
window. 

1.	 If you have not already done so, connect your video camera to your video capture 
card using the cable provided with the card. 

2.	 In the Project Media window, click the Open Video Capture button ( ). The video 
capture application you specified in the Video tab of the Preference window starts.
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3.	 Capture your video. For information on capturing video with the Sony Video 
Capture application, please see the Vegas Movie Studio online help. To access help, 
choose Contents and Index from the Help menu. 

Once you have captured your video, Video Capture adds the files to the Project 
Media window. If any captured clips go offline, you can recapture the clips using 
your video capture application. Right-click an offline file in the Project Media 
window and choose Recapture from the shortcut menu. 

Note: The commands on the Project menu also allow you to import video from a 

DVD camcorder, memory recording unit, or AVCHD camcorder. For more

information about importing video, please see the online help.


Getting images 

You can bring images directly into the software from your scanner, digital camera, or 
other TWAIN device. The images are added to the Project Media window as JPEG image 
files. 

1.	 Make sure your device (scanner or digital camera) is on and connected to your 
computer. 

2.	 In the Project Media window, click the Get Photo button ( ). The software is 
started for the device. 

3.	 Use the device software to get an image 
and send it to Vegas Movie Studio 
software. Once the image has been sent, 
the Scanned Files dialog appears. 

• 	Click  Rename to give the new image

a more meaningful name.


• Click  Delete to cancel adding the 

image.


4.	 Click Done. The new JPEG file is added to 
the Project Media list. 

Tip: If any of the subjects in your captured images have red eyes, you can use the 

red-eye removal feature to correct the problem. For more information on this 

feature, please see the online help.
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). The 

Extracting audio from a CD 

You can extract tracks from a CD and add them to the Project Media window as WAV 
files. 

Important: Vegas Movie Studio software is not intended for, and should not be used 
for, illegal or infringing purposes, such as the illegal copying or sharing of copyrighted 
materials. Using Vegas Movie Studio software for such purposes is, among other things, 
against United States and international copyright laws and contrary to the terms and 
conditions of the End User License Agreement. Such activity may be punishable by law 
and may also subject you to the breach remedies set forth in the End User License 
Agreement. 

1.	 Insert the audio CD into your CD/DVD drive. 

2.	 In the Project Media window, click the 
Extract Audio from CD button ( 
Extract Audio from CD dialog appears. 

3.	 From the Action drop-down list, choose 
the method you want to use for 
extracting the CD audio: 

•	 Read by track - Use this option to 

choose the tracks you want to

extract from the CD.


•	 Read entire disc - Use this option to

automatically extract all tracks on 

the disc. The entire CD is extracted 

into one new file in the Project Media list.


•	 Read by range - Use this option to extract audio from a specified range of time. 

4.	 If you chose either the Read by track or Read by range option, specify the track(s) 
or range to extract: 

• 	For  Read by track, select the tracks you want to extract in the Tracks to read list. 
Use the Ctrl or Shift keys to select more than one track. Each track is extracted 
into a separate file in the Project Media list. 

• For  Read by range, type a time in the Range start field and either the Range 
end or Range length fields. The range of audio is extracted into one new file in 
the Project Media list. 

Note: If you want to extract multiple tracks to a single file, choose Read by 
track from the Action drop-down list to select your tracks, and then choose 
Read by range from the Action drop-down list. The appropriate time range for 
the tracks you selected will automatically be inserted and the time range will be 
extracted to a single file. 
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5.	 From the Drive drop-down list, choose the drive containing the audio CD from 
which you want to extract. 

6.	 From the Speed drop-down list, choose the speed at which you want to extract the 
audio. If you experience any problems extracting audio, you can try decreasing the 
selected speed, or you can click Configure to adjust the Audio extract 
optimization setting. 

Note: To eject the CD at any time prior to beginning the extraction process, 
click the Eject button. 

7.	 Click OK. The Save As dialog appears. 

8.	 Select a name and location for the new WAV file. 

9. Click Save to begin extracting the audio.


The track is extracted and a progress meter is displayed to indicate the percent 

complete. Once extraction is complete, the new WAV file appears in the Project Media 
window. 

The option of automatically naming extracted tracks is provided for you. To enable this 
option, choose Preferences from the Options menu, and on the CD Settings tab, select 
the Autoname extracted tracks check box. 

Sorting media with bins 

The detailed view of the Project Media window helps you sort your media files using 
their attributes, but for more control, you can create bins. Bins are folders within 
projects that you can use to organize your media files. 

Media bins are virtual folders that are saved with your project. They do not affect the 
way media is saved on your computer. 

Creating bins 

Right-click the parent bin where you want to create a new bin and choose Create New 
Bin from the shortcut menu. 

Adding media to a bin 

1.	 Browse your existing bins to find the media file you want to move. The All Media 
Folder contains all media files in your project. 

2.	 Drag a file from the right-hand pane to a bin. 

For more information about media bins, see the online help (from the Vegas Movie 
Studio Help menu, choose Contents and Index). 
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Adding media to the timeline 

Media files may be added to your project from the Explorer or Project Media windows 
by double-clicking them or by dragging them. Either method places the media file in 
an event in its entirety in the timeline. 

Dragging a media file to the timeline 

You can create a new track by dragging a media file to a blank area on the timeline and 
dropping it in place. Tracks can contain multiple events, so you can place different 
events next to each other on a track. 

Note: Video and audio events cannot be placed on the same track.


1.	 Locate a media file in the Explorer or Project Media windows. 

2.	 Drag the media file to the timeline. 

An event for the media file appears where you released the mouse. 

Dragging multiple media files to the timeline 

1.	 Select multiple media files in the Explorer or Project Media windows. Select a range 
of adjacent media files by holding Shift and clicking the first and last files in the 
range or select files that are not adjacent by pressing Ctrl and clicking individual 
files. 

2.	 Right-click and drag the files to the track view (timeline). 
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3.	 When you release the mouse, a shortcut menu appears. Select a placement option 
from the menu. 

•	 Add Across Time 

•  Add As Takes 


You will see one event on the track. The other events 

are listed as takes “beneath” the topmost event.


•	 Video Only and Audio Only allow you to isolate either the video or audio, and 
add that stream from a multimedia file either across time or as takes. 

Tip: A left-click drag-and-drop automatically inserts files across time. However, you 
can cycle through placement modes by right-clicking (without releasing the left mouse 
button) while performing the drag-and-drop operation. 

Double-clicking a media file 

This method places the event at the cursor’s position in the selected track. If the 
selected track is a video track, and you double-click an audio event (or vice versa), a 
new track is created for the event. Once an event is placed, you can move it from one 
track to another or change its position on the timeline. 

Inserting a video file with associated audio 

Media files with video frequently include associated audio. When you insert a media file 
into the timeline, the associated audio is automatically inserted into a separate audio 
track below the video track. The two associated events are grouped together and 
behave as a single unit when moved or otherwise edited. You can ungroup the events 
to move them independently. 

Two events that contain video (top) 
and audio (bottom) streams from a 
single multimedia video file; each 
event is inserted on a separate track. 
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Automatically crossfading inserted events 

When inserting multiple events across time, the events (both video and audio) may be 
set to automatically crossfade. Two options must be enabled in order to create 
crossfades automatically when adding multiple events. First, verify that a check mark 
appears next to Automatic Crossfades in the Options menu. Second, from the Options 
menu, choose Preferences, and on the Editing tab, select Automatically overlap 
multiple selected media when added. For more information, see Crossfading events on 
page 43. 

Working with events 

Events are the most basic objects in a project. An event is something that happens in 
time, has a specific duration, and can be video or audio. 

Understanding files and events 

The objects you work with are referred to as media files and events. 

•	 Files are objects that are stored on your hard disk. In Vegas Movie Studio software, 
you will work with media files, such as music and video files. These files are neither 
operated on nor changed. You can access files from the Vegas Movie Studio 
Explorer window. 

•	 Events are periods of time on the timeline that act as windows into media files, 
either whole or in part. When you drag a media file onto the timeline, you 
automatically create an event that contains that file’s contents. An event can 
contain video, audio, still images, or generated media. The event window may 
contain only a small portion of a much larger media file. A single media file can be 
used repeatedly to create any number of different events, since each event can be 
trimmed independently. 

The original media file. 

An event trimmed from the original media file. 

The event as it appears in Vegas Movie Studio software. 

Audio events are created from audio files on your computer (for example, WAV or 
MP3) or can be a part of a video file (for example, AVI). You can change many 
characteristics of an audio event, such as speed, volume, and equalization. Audio 
events can be mixed with other audio events. 
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Video events are created from video files captured to your computer (typically AVI, 
MOV, or QT) or images (BMP, JPEG, PNG, or TGA). You can change many 
characteristics of a video event, such as speed, color, and size. Video events can 
overlay other video events and are visual elements that appear on top of a 
background video, image, or color. 

Moving events along the timeline 

You can move events along the timeline individually or as a group. Events may overlap 
each other or be placed on top of each other. You can crossfade overlapping events 
automatically or with envelopes. 

Moving an event 

You can move an event along the timeline within a track or move it to a different track. 

1. Drag the event along the timeline. 

If you move the event along the original track’s timeline, the event’s appearance 
(color) remains the same. 

However, you may move the event to a different track. When you do, the event 
appears as a simple outline and you will see its original track and position on the 
timeline. Once you release the mouse, the event assumes the new timeline position 
and track color. 

Original track position


New track and position


2. Release the mouse to place the event. 

Moving multiple events 

You can move multiple events along the timeline within a track or move them to a 
different track. Selected events do not need to be within the same track. Use the Ctrl 
key, the Shift key, or the Selection Edit Tool ( ) to select multiple events and drag 
them. To select all events on the track after a given event, right-click the event and 
choose Select Events to End. For more information, see Selecting multiple events on page 
32. 
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Moving events by small increments 

To move an event more precisely, click the event and press 4 or 6 on the numeric 
keypad to nudge it by small increments. The amount of movement caused by each 
nudge is determined by how far the timeline is zoomed in or out. You can also click the 
event and press 1 or 3 on the numeric keypad to nudge the event by frames. 

Working with tracks 

A project consists of multiple audio and video tracks. The track view is the timeline in 
which all events appear. The track list provides information about the track and 
contains controls that affect all events in the track. 

Using the track view 

Numerous options are provided for viewing and navigating in track view. 

Scrolling and zooming 

There are several ways to scroll and zoom in the track view. 

•	 Click the scroll bar arrows or drag the scroll bars to move up and down the tracks or 
to move forward and back along the timeline. 

• 	Click the  Zoom buttons ( ) to reveal more or less of the timeline. 

•	 Drag the edge of the scroll box, found on the scroll bar, to zoom. 

•	 Press and  to zoom in and out along the 
timeline. 

• 	Click the  Zoom Edit Tool ( ) button or, from 

the Edit menu, choose Editing Tool and then 

choose Zoom. In this mode, drag on the Scroll box
 Zoom 

timeline to draw a rectangle that defines the 	 tools 

zoom region. 

Tip: You can also access the Zoom Edit Tool from the lower-right corner of the track 
view ( ). 

Zooming directly controls the accuracy of your editing. Each video event has 
thumbnail representations of the frames within the event. Depending on how far you 
have zoomed in on a video event, a thumbnail can represent the entire event or a 
single frame in the event. 
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Changing track height 

You can change the height of individual tracks by dragging their borders in the track 
list. In the example below, the main video track is fairly large to show the details of the 
scene while the two tracks above it, which are overlays, have been resized to a shorter 
height. 

Using the track list 

This section describes the different controls in the track header of each track. Some 
controls are specific to either video or audio tracks. 

Video track header 

Button or 
Control 

Name 

Minimize 
track height 

Maximize 
track height 

Description 

Minimizes track height. 

Maximizes track height. 

Track Track numbers and colors help organize a multitrack project. 
number and 
color 

Track name Allows you name a track. To name a track, double-click the 
(scribble scribble strip and type the track’s name. 
strip) 

Track motion 

Track FX 

Track motion is used to move a video track across a 
background. Picture-in-picture effects and scrolling title 
sequences are two simple cases where this tool is important. 

Adds track effects plug-ins. 

Mute Temporarily mutes playback of the track so that you can focus 
on other tracks. 

Solo Isolates a track for playback. 
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Button or 
Control 

Name Description 

Compositing Determines how the transparency in a video track is generated. 
mode 

Make Creates a parent/child compositing relationship with the track 
compositing above. 
child 

Audio track header


Button or Name Description 
Control 

Minimize track Minimizes track height. 
height 
Maximize track Maximizes track height. 
height 
Track number and Track numbers and colors help organize a 
color multitrack project. 
Track name Allows you name a track. To name a track, double­
(scribble strip) click the scribble strip and type the track’s name. 
Arm for record Prepares a track for recording. You may record 

directly into audio tracks. A track is ready when you 
see the recording meter appear on it. 

Track FX Adds track effects plug-ins. 

Mute Temporarily mutes playback of the track so that you 
can focus on other tracks. 

Solo Isolates a track for playback by muting the other 
tracks. 

Volume fader Controls the audio track volume relative to the 
other tracks. Drag the fader left or right to adjust 
the volume. 

Pan slider Functions as a trim control that adjusts the overall 
panning of the track. 

Playing back and previewing 

You can play back your project in two ways: directly from the timeline from within the 
software or by mixing the entire project to a preview file. 
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Playing your project 

The transport bar allows you to play back your entire project or portions of your project 
based on a time selection or the current cursor position. 

Play from cursor position

Loop playback Stop Cursor to end


Record Play from start Pause Cursor to start 

If your project includes video, make sure the Video Preview window is displayed for 
playback: from the View menu, choose Video Preview or press Alt+6. 

Playing an entire project 

1.	 Click the Play From Start button ( ) to begin playback at the beginning of the 
project. 

2.	 Click the Stop button ( ) to stop playback. 

Most of the time, you will only want to preview a small portion of the project to perfect 
a section. You can do this by creating a time selection. 

Playing a time selection 

1.	 Place the mouse pointer above the ruler on Loop bar 
the marker bar. The mouse pointer changes 
to include a left/right arrow cursor ( ). 

2.	 Drag to select the time region. To increase or 
decrease the time selection, drag its start and 
end points. The time selection is highlighted 
and the loop bar appears above the ruler on 
the timeline. 

3.	 Click the Play button ( ) to begin playback. Only the non-muted tracks and events 
within the time selection play back. 

4.	 Click the Loop Playback button ( ) to continually play back the events within the 
time selection. Click the button again to turn this feature off. 

5.	 Click the Stop button ( ) to stop playback. 

By looping the playback, you can repeatedly watch the same section of the project over 
and over as you make changes to filters and effects in real time. You can define 
selection areas automatically, depending on what you would like to preview. For more 
information, see Selecting a time range on page 33. 
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Scrubbing 

Scrubbing is a type of timeline playback that gives you precise control over the speed 
and direction of playback. Both linear and logarithmic scale scrubbing are allowed. 

The use of multimedia controllers is supported for scrubbing. For more information on 
using the software with multimedia controllers, please see the online help. To access 
help, choose Contents and Index from the Help menu. 

Tip: Choose a setting from the JKL/shuttle speed drop-down list on the Editing tab of 
the Preferences dialog to control the scrub speed and range when using the keyboard 
or multimedia controllers. 

Scrubbing with the playhead 

The playhead ( ) above the timeline can be dragged Drag playhead to scrub 
back and forth to shuttle forward or backward from the 
cursor position to locate an edit point. 

Tip: Set in and out points while dragging the 

playhead by pressing the I and O keys.


Note: The playhead is also available in the Trimmer 

window.


Previewing to media player 

A project can be previewed in a media player by mixing and rendering the project 
according to the project’s properties and playing back using the media player 
associated with the file type you select. 

1. From the Tools menu, choose Preview in Player. The Preview dialog appears. 

2. Select the file type from the drop-down list. 

3. Click OK to begin the mixing and rendering process. A progress dialog appears 
indicating the percent complete of the new file. 

When mixing is completed, the associated media player opens and begins playback. 
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Chapter 3
 Basic Editing Techniques  

Vegas® Movie Studio™ projects are multitrack compilations of events that 
occur over time. The events in your project are references (pointers) to 
source media files. Vegas Movie Studio software is a nondestructive editor, 
so editing events in your project does not alter the source media files in any 
way. 

Getting around 

When editing and playing back the project, the cursor identifies where you 
are along the project’s timeline. 

Moving the cursor 

Use the following keyboard commands to move the cursor in the timeline. 

Description Keys Description Keys 
Go to beginning of Ctrl+Home Move left/right to marker(s) Ctrl+Left/Right 
project or W Arrow 
Go to end of project Ctrl+End Move to marker # 0-9 keys (not 

or E numeric keypad) 
Go to beginning of Home Move left/right to event edit Ctrl+Alt+Left/ 
selection points including fade edges Right Arrow 
or view (if no selection) (see figure below) 
Go to end of selection End Nudge cursor on timeline Left or Right 
or view (if no selection) Arrow 
Move right by grid Page Down Move left/right one frame Alt+Left/Right 
marks Arrow 
Move left by grid marks Page Up Move left/right one frame Ctrl+Alt+Shift+M 

ouse wheel 
Go to Ctrl+G Center in view \ 

Event edit point cursor jumps 

Changing focus 

Focus is used to describe which objects have the attention of a program. 
For example, when you click a file in the Project Media list, the Project Media 
window has focus. To instantly switch the program’s focus to the track view 
(timeline), press Alt+0 or, from the View menu, choose Focus to Track View. 
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In Vegas Movie Studio software, it matters which track has focus when you perform a 
task. For example, when you double-click a media file in the Explorer, it is inserted into 
the track that has focus. You can click a track on its track number to make it the focus 
track. A blinking white line under the track number and shading in the track list 
indicates a track has focus. 

Making selections 

You have the flexibility to select one or more events, a time range, or events and a time 

range. All selection options can apply to a single track or to multiple tracks.


To select an event, click it.


Selecting multiple events 

You can select multiple events in your project using several methods. 

Tip: Once you have selected multiple events, you can group them together. 

Note: You can select multiple video events, multiple audio events, or a combination of 
both video and audio events. However, you can only use commands and operations 
that apply to both types of events for selections composed of both audio and video 
events. 

Selecting nonadjacent Selected events 
events 

1.	 Hold the Ctrl key. 

2.	 Select the events by 
clicking them. 

To deselect an event, simply 
click it again to toggle the 
event selection on or off. 

Selecting a range of events 

1.	 Hold the Shift key. 

2.	 Click the first event that you want to select. 

3.	 Click the last event that you want to select. 

All events between the first and last selected events are highlighted and selected. 

Selected events 
32 | BASIC EDITING TECHNIQUES 



VegasQSG.book  Page 33  Monday, June 16, 2008  10:11 AM
Selecting a block of events 

1.	 Click the Selection Edit Tool button ( ). 

2.	 Position the cursor in a corner of the area that 
you want to select. 

3.	 Click and hold the left mouse button. 

4.	 Drag the cursor to the opposite corner of the 
area you want to select. A rectangle is drawn on 
the workspace. All events within this rectangle 
are selected. 

Hold the left mouse button and right-click to toggle through the three types of 
selection boxes: free, vertical, or horizontal. 

Tip: You may include or exclude events from a selection area by pressing Ctrl and 
clicking an event. To deselect all events, click anywhere in the workspace outside of the 
selected events. 

Selecting all events to the end of the track 

1.	 Right-click an event. A shortcut menu appears. 

2.	 From the shortcut menu, choose Select Events to End. All events on the track after 
the selected event are selected. 

Tip: To move large blocks of events, you can use Select Events to End with events

selected on different tracks. Press Ctrl and click to select events on different tracks, 

and then right-click to access the shortcut menu.


Selecting a time range 

Time selections are indicated by a shaded 
box and a bar that appears on the top of the Time selection 
timeline. You can use the time selection bar 
for playing back a smaller portion of your 

Only theproject or to apply cross-track edits. 
events within 
the time 

Note: Unless an event is locked, a selection are 
selected time range affects all events, or affected by 
portions of events, that occur within the edits or 

played back. range. 
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Dragging to select a time range 

1.	 Position the mouse pointer above the ruler (on the marker bar). The mouse pointer 
changes to a left/right arrow cursor ( ). 

2.	 Drag to select a region. All events, or portions of events within the region, are 
highlighted. 

3.	 Drag the yellow handles on either end of the time 
selection to increase or decrease your time range 
selection. 

Tip: You can move the entire selection range by

dragging the time selection bar.


Looping playback 

If you want to play back the time range, click Play ( ) to play only the events within 
the time range. Click the Loop Playback button ( ) or press Q to toggle loop playback 
on and off. Vegas Movie Studio software continually plays back the portion of the 
timeline within the time selection when loop playback is on. 

Selecting events and a time range 

Selecting a time range does Time selection 
not automatically select 
events. Excluding locked 
events, all items within the 

Unselected time range play back and are Selected 
event affected by Edit menu event 

commands. However, you may Unselected Selected 
select specific events to edit, event event 
and then select a time range. 

Unselected Selected 
1.	 Select the events you wish event event 

to edit. For more

information, see Selecting 

multiple events on page 32.


2.	 Place the mouse pointer above the ruler (on the marker bar). The mouse pointer 
changes to a left/right arrow cursor ( ). 

3.	 Drag to select the region. Notice that events that were not initially selected in step 
1 remain unselected (not highlighted). 

Selecting tracks 

Click a track header to select it. Hold Ctrl or Shift to select multiple tracks. 
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Editing events 

Copying events 

You can copy events, or portions of events, to the clipboard and paste them into your 
project. You may copy a single event or multiple events. Copying preserves the original 
event information, edits, and other modifications. 

1.	 Select the events to be copied. For more information, see Selecting multiple events on 
page 32. 

2.	 Select a time range, if applicable. 

3.	 Click the Copy button ( ). 

Copying selected events 

When copied, selected events are reproduced and placed on the clipboard. Time 
information is also placed on the clipboard. 

Events before copy Clipboard contents Events after copy 
The original events 
are not affected and 
do not change. 

Copying a time selection 

Events within the time selection and across all tracks are reproduced and placed on the 
clipboard. Time information is also placed on the clipboard. 

Events before copy Clipboard contents Events after copy 
The original events 
are not affected and 
do not change. 
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Copying a time selection and events 

Events and portions of selected events within the time selection are reproduced and 
placed on the clipboard. Time information is also placed on the clipboard. 

Events before copy Clipboard contents Events after copy 
The original events 
are not affected and 
do not change. 

Cutting events 

Cutting events removes them from their respective tracks, but places the cut 
information (events and time) on the clipboard. Once on the clipboard, you may paste 
the information into your project. 

Tip: You can apply a ripple edit after cutting. For more information, see Crossfading 
events on page 43. 

1. Select events or a time range. For more information, see Making selections on page 
32. 

2. Click the Cut button ( ). 

Cutting selected events 

When cut, selected events are removed from the timeline and placed on the clipboard. 
Time information is also placed on the clipboard. 

Events before cut Clipboard contents Events after cut	 Events after cut in 
post-edit ripple 
mode 
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Cutting a time selection 

Events within the time selection are reproduced and placed on the clipboard. Time 
information is also placed on the clipboard. When cutting a time selection, ripple edit 
mode affects the position of material on all tracks or affected tracks after the cut. 

Events before cut Clipboard contents Events after cut	 Events after cut in 
post-edit ripple 
mode 

Cutting a time selection and events 

Events and portions of selected events within the time selection are reproduced and 
placed on the clipboard. Time information is also placed on the clipboard. When 
cutting a combination of time selection and event selection, post-edit ripple mode 
affects the position of material on all tracks or the tracks of selected events after the cut. 

Events before cut Clipboard contents Events after cut	 Events after cut in 
post-edit ripple mode 

Pasting events 

Once information is copied to the clipboard, you may choose a variety of ways to paste 
the clipboard items. Items are always pasted from the cursor’s position along the 
timeline. 

When post-edit ripple mode is enabled, material is pushed down the track to make 
room for pasted material. The exact behavior of the ripple depends on what is being 
pasted, and the type of ripple edit you chose to perform. If one or more events are 
pasted, only those tracks where pasted material appears are ripple edited. 

Tip: You can apply a ripple edit after pasting. For more information, see Crossfading 
events on page 43. 
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1.	 Move the cursor to the desired location on the timeline. 

2.	 Click either the track number or within the track where you want to paste the 
event. This track is the focus track; there can be only one focus track at a time. 

Note: If you are pasting multiple events from different tracks, new tracks are 
automatically created as needed. 

3.	 Click the Paste button ( ). 

Clipboard events are pasted at the cursor position on the track. Existing track 
events can be overlapped with newly pasted information. 

Using paste repeat 

Use paste repeat to specify how many times clipboard events are pasted at the cursor 
position on the selected track and to specify the space between pasted events. 

1.	 Copy a selection to the clipboard. 

2.	 From the Edit menu, choose Paste 
Repeat. The Paste Repeat dialog 
appears. 

3.	 Specify the number of times to paste the 
clipboard contents and the space 
between successive copies. 

4.	 Click OK. 

Using paste insert 

When using paste insert, clipboard events are placed at the cursor position on the 
selected track and existing events on all tracks are moved further down the timeline by 
the total length of pasted information. This action differs from post-edit ripple mode 
because pasting in post-edit ripple mode affects only the tracks in which material is 
pasted, while paste insert affects all tracks in the project. 

1.	 Copy a selection to the clipboard. 
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2. From the Edit menu, choose Paste Insert.


Clipboard contents Events before paste insert Events after paste insert


Events on all tracks (not just tracks with 
pasted material) are pushed down the 
timeline. 

Punching-in and crossfading events 

You can insert events into the middle of (on top of ) existing events without altering the 
timing of the project. When the inserted event ends, the original event continues 
playing as if it had never stopped. 

You can choose the duration of crossfades for punched-in audio events. 

1. From the Options menu, choose Preferences. The Preferences dialog appears. 

2. Click the Editing tab. 

3. Select Quick fade length of audio events. Specify a duration for each transition. 

Events that have previously been inserted or punched-in are not affected by this 
change. The concept of punching in and out only applies when you are inserting an 
event that is shorter than the event that it is being inserted into. In the following 
illustration, every frame is numbered so that you can see how the original event 
continues after the inserted event ends, as if it continued to play underneath the 
original. 

Punched-in event 

Duplicating events 

Duplicating is a combination of copying and pasting in one action. The process is like 
moving the event to a new position while leaving a copy behind. 
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( ).  

1.	 Press Ctrl. 

2.	 Drag the event you want to duplicate to the place where you want the new event 
to be positioned. 

Trimming events 

This section describes simple ways to trim events. 

Tip: You can apply a ripple edit after trimming an event. For more information, see 
Crossfading events on page 43. 

Trimming an event 

During the trimming process for a video event, both the last thumbnail image on the 
event and the Video Preview window show the last frame in the event, allowing you to 
edit events very accurately. 

1.	 Move the cursor over the edge of the event. 
The cursor changes when properly positioned 

Trimming 2.	 Drag the edge of the event to trim it. 
grouped 

Since a multimedia file often has both a video and events at the 
an audio component, both events are trimmed (or same time 
extended) as a group unless you ungroup them or 
temporarily suspend grouping by clicking the 
Ignore Event Grouping button ( ). 

Trimming an event beyond its end 

You can trim an event beyond its end, extending it as a result. Once extended, the 
event loops as a default. A notch indicates where the looped event repeats. 

Alternately, you can turn looping off and make the last frame of an event’s media 
repeat for the duration of the event (a freeze frame). A notch appears at the point in the 
event where the video ends and the freeze frame begins. 

Trimming adjacent events 

You can trim adjacent events simultaneously. Press Ctrl+Alt while dragging the 
common edge between two adjacent events. The trim adjacent cursor appears ( 
Press Ctrl+Alt over the ...and drag left... ...or right to trim both events 
boundary between two at once. 
events... 

). 
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Trimming a time selection 

Trimming events removes all media outside the time selection. The removed 
information is not placed on the clipboard. Trimming is different from cutting in that 
the events within the time selection are preserved. 

1. Select a time range. For more information, see Selecting a time range on page 33. 

2. Press Ctrl + T or, from the Edit menu, choose Trim. 

The material outside the time selection (across all tracks) is removed from the project. 
However, the time information (space) between events is not removed. 

Events before trim Clipboard contents Events after trim 
Trimmed information 
is not placed on the 
Clipboard. 

Splitting events 

You are allowed to create multiple, independently functioning events from a single 
event by splitting it. Splitting creates a new ending point for the original event and 
creates a starting point for the newly created event. 

Splitting an event does not alter the original 
One event 

media. The original media file’s information 
is there, but is omitted for playback based 

Split positionon where the event’s starting or ending 
point occurs on the timeline. Two events after 

splitWhen split, the two new events are flush 
against one another. The two events can be 
moved independently. The two new events 

can be moved 
independently. 

Splitting an event 

1. Select the event(s) to be split. For more information, see Making selections on page 
32. 

2. Place the cursor at the timeline position where the split will occur. 

3. From the Edit menu, choose Split, or press S. 
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Splitting all events at the cursor 

All events are split at the cursor’s position (unless an event is locked). The split occurs 
across all tracks (if no events are selected). 

Events before Events after 

splitting splitting


Splitting selected events 

Only the selected events are split at the cursor’s position. 

Events before Events after 
splitting splitting 

Splitting a time selection 

Unless locked, all events within the time selection are split at the starting and ending 
points of the time range, meaning that two splits are made. The split occurs across all 
tracks. 

Events before Events after 

splitting splitting
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Deleting events 

Deleting an event removes it from its track. Multiple events can be deleted and time 
selections can be used to modify the process. Ripple editing also applies to delete 
actions. Deleting operates exactly like a cutting operation, but the removed 
information is not placed on the clipboard. For more information, see Cutting events on 
page 36. 

1.	 Select the events to be deleted. 

2.	 Press Delete. 

Crossfading events 

You are allowed to crossfade between 
two events on the same track. For 
audio events, crossfading fades out one 
audio event’s volume while another 
event’s volume fades in. For video 
events, crossfading creates a transition 
between two events, one fading out while the other fades in. Lines appear indicating 
how and when the event’s volume or transparency is being affected. 

Using automatic crossfades 

The automatic crossfade feature turns the overlapping portions of two events into a 
smooth crossfade. This feature is turned on as a default. Click the Automatic 
Crossfades button ( ) or press Ctrl+Shift+X to turn automatic crossfades on and off. 

Event before crossfade	 Event after crossfade 

Fade in 
volume line 

Fade out 
volume line 

Drag one event 
to overlap the 
other 

An option is provided for creating automatic crossfades when you add multiple media 
files to a track. For more information, see Using automatic crossfades on page 43. 

Manually setting a crossfade 

An automatic crossfade is not inserted if a shorter event is placed on top of and within 
the same time frame of a longer event. In this case, the longer event begins playing, 
then the shorter event plays, and then the longer event resumes playing at the timeline 
position. You can manually create a crossfade to fade in and out of the shorter event. 

1.	 Place the mouse pointer on one of the shorter event’s handles. The envelope cursor 
appears ( ). 

2.	 Drag the handle to the desired position. 
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Events without crossfade Events with manual crossfade 

This is a fast and effective method of inserting a voiceover on top of a background 
music track (although the music fades out completely) or to replace a bad section of 
audio. For more information, see Punching-in and crossfading events on page 39. 

Changing crossfade curves 

You can change the crossfade curves that are used to fade in and out between two 
events. 

Right-click a crossfade to 
.choose a different 
crossfade curve 

1.	 Right-click anywhere in the crossfade region to display a shortcut menu. 

2.	 From the shortcut menu, choose Fade Type, and choose the desired fade type 
from the submenu. 

Tip: If you use the same crossfade curve frequently, you can set it as a default for all 

new audio or video crossfades on the Editing tab of the Preferences dialog using the 

Audio default type and Video default type drop-down lists.


Using undo


Pressing Ctrl + Z or clicking the Undo button (
 ) reverses the last edit performed. 
Repeatedly using the keyboard command or toolbar button continues undoing edits in 
reverse order, from most recent to oldest. In addition, you may undo the last edit by 
choosing it from the Edit menu. 

Undoing a series of edits


You can undo a series of edits by using the drop-down list on the Undo button.


1.	 Click the arrow to the right of the Undo button ( 

2.	 From the drop-down list, choose the edit that you want to undo. Items above it 
(subsequent edits) are selected automatically. Your project is restored to the state 
prior to those edits. 

). 
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Use the mouse to 
select a series of 
edits. 

When you undo an edit or a series of edits, they are added to the redo history. This 
feature allows you to restore your project to a previous state. 

Tip: From the Edit menu, choose Undo All to undo all edits in the history. All edits 
are undone and added to the redo history. 

Using redo


Pressing Ctrl+Shift+Z or clicking the Redo button (
 ) redoes the last undo performed. 
Repeatedly using the keyboard command or toolbar button continues redoing undos 
in reverse order, from most recent to oldest. In addition, you may redo the last edit by 
choosing it from the Edit menu. 

Redoing a series of edits 

You can view the redo history by clicking the arrow on the right side of the Redo 
button ( ). The top item in the list that appears is the most recent undo edit. If you 
redo a specific edit that appears farther down the list, all subsequent edits above it are 
redone as well. 

When you redo an edit or a series of edits, they are added to the undo history again. 
The redo history is cleared when a new edit is performed. 

Note: You are given unlimited undo and redo functionality while working on your 

project, even to the extent of being able to undo changes made before the last time 

a project was saved (but not closed). While you are working with a project, an undo 

history of the changes that you have performed is created. Each time you undo

something, that change is placed in the redo history.


When you close the project or exit the software, both the undo and redo histories 

are cleared.
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Adding project markers and regions 

Several types of project markers are provided that identify parts of your project, serve 
as cues, and provide additional functionality: 

•	 Markers are points that you mark along the project’s timeline. They are typically 
used to mark locations in the project for later reference or to mark timing cues. 

•	 Regions are ranges of time that you mark along the timeline. Regions identify 
ranges of time for your reference and can function as permanent time selections. 

•	 CD layout markers are markers that indicate tracks and indexes for an audio CD 
layout. These marks are used to create tracks and index points when burning an 
audio CD. 

Tip: You can use ripple editing to automatically move markers and regions as you 
edit in the timeline. For more information, see Crossfading events on page 43. 

Working with markers 

Markers are useful for identifying and navigating to specific locations in longer 
projects. As you place markers in your project, they are automatically numbered (up to 
99) in the order that they are placed. Markers appear as orange tags above the ruler. 
You may name them and reposition them along the project’s timeline. 

Markers 

Marker 
bar 

Right-click the marker bar 

Inserting a marker at the cursor 

1.	 Position the cursor where you want to place the marker. 

2.	 From the Insert menu, choose Marker, or press M. 

3.	 Type a name for the marker and press Enter. If you do not want to name the marker, 
simply press Enter. 

Inserting a marker during playback 

During playback, press M. The marker appears on the marker bar. You may name the 
marker after it has been set. 
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Naming (or renaming) a marker 

1.	 Place the mouse pointer on the marker you want to name or rename. The pointer 
changes to a hand icon ( ). 

2.	 Right-click to display a shortcut menu. 

3.	 From the shortcut menu, choose Rename. A text 
box opens next to the marker. 

4.	 Type the marker name. 

5.	 Press Enter to set the marker’s name. 

You can also double-click an existing name or double-click the space just to the right of 
a marker to rename it. 

Moving markers 

You can reposition a marker by dragging it on the marker bar. 

Navigating to markers 

You can jump the cursor to any marker on the timeline by clicking the marker. You can 
also jump to a marker by pressing the number keys along the top of the keyboard (not 
the numeric keypad). 

Tip: Jump the cursor to the next or previous marker by pressing Ctrl + Right Arrow 
or Ctrl + Left Arrow. 

Deleting markers 

1.	 Place the mouse pointer on the marker that you want to delete. The pointer 
changes to a hand ( ). 

2.	 Right-click to display a shortcut menu. 

3. From the shortcut menu, choose Delete. The marker is removed from your project. 

The tags are not renumbered as you remove them. For example, if you have five 
markers in your project and delete markers 3 and 4, the remaining markers will be listed 
as 1, 2 and 5. However, as you add markers again, Vegas Movie Studio software begins 
numbering the missing sequence first, in this case 3 and 4, then 6, 7, 8, etc. 

Deleting all markers and regions 

1.	 Right-click the marker bar. 

2.	 From the shortcut menu, choose Markers/Regions, and choose Delete All from the 
submenu. 
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Working with regions 

Regions identify ranges of time and provide a way to subdivide your project. A region is 
defined as the area between two region markers that share the same number. Regions 
can function as semi-permanent time selections. You can view region information in 
the Explorer by clicking the arrow next to the View button ( ) and selecting Region 
View. 

Inserting regions 

1.	 Make a time selection. For more information, see Selecting a time range on page 33. 

2.	 From the Insert menu, choose Region, or press R. 

3.	 Type a name for the region and press Enter. If you do not want to name the region, 
simply press Enter. 

Region markers appear at the beginning and end points of a time selection. 

Region start Region end Right-click the marker bar 

Marker bar 

Moving regions 

Drag a region marker to reposition it. To move both region markers (start and end 
markers) at once, hold Alt while dragging a region marker. 

Naming regions 

1.	 Place the mouse pointer on the left region marker you want to name or rename. 
The pointer changes to a hand icon ( ). 

2.	 Right-click to display a shortcut menu. 

3.	 From the shortcut menu, choose Rename. A text box 
appears next to the region marker. 

4.	 Type the region’s name. 

5.	  Press Enter or click anywhere in the track view to set the 
name. 
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Selecting regions 

You may select the events, across all tracks, within the region for editing or playing 
back. 

1.	 Right-click one of the region markers to display a shortcut menu. 

Selected region 

2.	 From the shortcut menu, choose Select Region. 

Tip: You can also select a region by pressing a number on your keyboard (not the 
numeric keypad) or by double-clicking a region marker. 

Navigating to regions 

You can move the cursor to the start or end of a region by clicking either region marker. 
You may press Ctrl + Right Arrow or Ctrl + Left Arrow to move the cursor to the next or 
previous region markers. 

Right-click a region marker to display a shortcut menu that allows you to navigate to 
the beginning (Go to Start) or the end (Go to End) of a region. 

Deleting regions 

1.	 Place the mouse pointer on the region marker’s starting or ending point. The 
pointer changes to a hand icon ( ). 

2.	 Right-click to display a shortcut menu. 

3. From the shortcut menu, choose Delete. The region is removed from your project. 

The tags are not renumbered as you remove them. For example, if you have five 
regions in your project and delete region 3 and 4, the remaining regions are listed at 1, 
2 and 5. However, as you add regions again, Vegas Movie Studio software begins 
numbering the missing sequence first, in this case 3 and 4, and then 6, 7, 8, etc. 

Deleting all regions and markers 

1.	 Right-click the marker bar. 

2.	 From the shortcut menu, choose Markers/Regions, and choose Delete All from the 
submenu. 
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Using an external audio editing program 

Vegas Movie Studio software is a nondestructive editing environment, which means 
that the original source files remain unchanged by any editing done in the software. 
Destructive edits that modify the actual source media file may be done in a separate 
application such as Sound Forge® software from Sony Creative Software Inc. By setting 
up a separate audio editor, you can quickly access the program from Vegas Movie 
Studio software via the Tools menu or by pressing Ctrl+E. 

Setting up an audio editing program 

If you already have Sound Forge software loaded on your computer when you installed 
Vegas Movie Studio software, the installation should have detected it and made it your 
default audio editing program. However, if you do not have Sound Forge software or 
want to specify a different audio editor, you may do so in the Preferences dialog. 

1.	 From the Options menu, choose Preferences. The Preferences dialog appears. 

2.	 In the Preferences dialog, click the Audio tab. 

3.	 Click the Browse button to the right of the Preferred audio editor box. The 
Preferred Audio Editor dialog appears. 

4.	 From this dialog, navigate to the application to use for editing audio files. 

5.	 Select the application’s executable icon (.exe) and click Open to set the application 
as your default audio editor.


The application’s path appears in the Preferred audio editor box.
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Chapter 4
 Saving and Rendering Projects  

What do you do after you’ve added the final touches to your movie and it’s 
ready to be shown to the world? Vegas Movie Studio Platinum allows you to 
easily save and render your projects so you can amaze your family and 
friends. 

Make Movie Wizard 

After you’ve completed your masterpiece, you can use the Make Movie 
Wizard to save your project in a variety of formats. 

Note: Opening the Make Movie Wizard is the same for all formats listed 
below. From the Project menu, choose Make Movie, or click the Make 

Movie  button on the toolbar. 

Save it to your hard drive 

1.	 Select the Save it to my hard drive radio button and click Next. The 
Render Settings page appears. 

2.	 Choose File path, Format, Template, and other settings that will be 
used to save your file, and then click Next. 

Note: For more rendering options, click Advanced Render on the 
Render Settings page. 

3.	 The project begins to render to your hard drive. When it’s complete, 
click Finish to close the Make Movie Wizard. 

Burn it to DVD 

1.	 Select the Burn it to a DVD, Blu-ray Disc, or CD radio button, and click 
Next. The Burn a Disc page appears. 

2.	 Select the DVD radio button and click Next. The Render Settings page 
appears. 

3.	 Choose Video file path, Audio file path, and other settings to indicate 
where the file will be created and click Next. 

4.	 The project will begin to render to your hard drive. 
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5.	 When it’s complete, click Send to DVD Architect Studio to start DVD Architect 
Studio and create a project with your movie. 
- or ­
Click Finish to close the Make Movie Wizard. 

Note: For more information about using DVD Architect Studio software, please 
refer to its documentation. 

Burn it to Blu-ray Disc

 This feature is available only in Vegas Movie Studio Platinum. 

1.	 Select the Burn it to a DVD, Blu-ray Disc, or CD radio button and click Next. The 
Burn a Disc page appears. 

2.	 Select the Blu-ray Disc radio button and click Next. The Burn Blu-ray Disc dialog 
appears. 

3.	 Select a radio button to choose what you want to do: 

•	 Render image and burn: renders your current project as a Blu-ray compliant 
file and burns it to disc. 

•	 Render image only: renders your current project as a Blu-ray compliant file 
that you can burn at a later time. 

•	 Burn existing image file: burns an already-rendered file to a Blu-ray Disc. 

4.	 If you selected the Render image and burn or Render image only radio button, 
choose your rendering settings: 

a.	 Choose a setting from the Video template drop-down list to specify the 
parameters that should be used for rendering your video stream. 

b.	 Choose a setting from the Audio template drop-down list to specify the 
parameters that should be used for rendering your audio stream. 

c.	 Select the Render loop region only check box if you want to use only a portion 
of your project. If the check box is cleared, the entire project will be rendered 
and burned to the Blu-ray Disc. 

d.	 Select the Stretch video to fill output frame check box if you want to reformat 
your video so it fills the output frame size listed in the Description box. When 
the check box is cleared, the current aspect ratio is maintained, and black 
borders are added to fill the extra frame area (letterbox). This option is useful 
when the desired output format does not match the frame aspect ratio of your 
project. 

e.	 Select the Insert chapter points at markers check box if you want to use 
markers from the timeline as chapter points in your rendered file. 

5.	 If you selected the Render image and burn or Render image only radio button, the 
File path box displays the folder and file that will be used to render your project. 

If you selected the Burn existing image file radio button, type the path to the file 
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you want to burn in the File path box (or click the Browse button to locate the file). 

6.	 Select recording options for your Blu-ray drive: 

a.	 Choose a drive from the Burn drive drop-down list to specify the drive you 
want to use. 

b.	 From the Burn speed drop-down list, choose the speed at which you want to 
record. Max will record using the fastest speed possible with your drive; 
decrease the speed if you have difficulty recording. 

c.	 Select the Eject when done check box if you want to eject the disc 

automatically when burning has completed.


7.	 Click OK to start rendering your project and burning your disc. 

Burn it to Video CD (VCD) 

1.	 Select the Burn it to a DVD, Blu-ray Disc, or CD radio button, and then click the 
Next button. The Burn a Disc page appears. 

2.	 Choose the Video CD radio button and click Next. The Burn Video CD dialog 
appears. 

3.	 From the Burn drive drop-down list, use the CD drive that you want to use to burn 
your Video CD. 

4.	 From the Burn speed drop-down list, choose the speed at which you want to burn. 
Max will use your drive’s fastest possible speed; decrease the setting to prevent the 
possibility of buffer underruns. 

5.	 Select your burning options: 

Option Description 
Buffer 
underrun 
protection 

Automatically If you’re burning to rewritable media, select this check box to erase the disc 
erase before burning. 
rewritable 
discs 
Eject when Select this check box to eject the CD automatically when burning has 
done completed. 

Select this check box if your CD recorder supports buffer underrun 
protection. Buffer underrun protection allows a CD recorder to stop and 
resume burning. 

Note: Buffer underrun protection can create a disc that can be played in CD 
players, but may contain a bit error where burning stopped and restarted. 
Consider clearing this check box when creating a premaster disc. 

6. Choose a radio button in the Burn mode area: 

Option Description 
Burn CDs Begins recording the video file to your CD immediately. 
Test first, then Performs a test to determine whether your file can be written to the CD 
burn CDs recorder without encountering buffer underruns. The file is not recorded to 

the CD during the test, and recording begins after the test if it is successful. 
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Option Description 
Test only (do Performs a test to determine whether your file can be written to the CD 
not burn CDs) recorder without encountering buffer underruns. The file is not recorded to 

the CD. 

7.	 Choose the movie file you want to use: 

•	 If you want to render the current project, select the Render format radio 
button. 

a.	 Edit the contents of the File path box to specify the name and location of 
your rendered file. 

b.	 Choose a template from the Template drop-down list to specify the 
parameters that should be used for rendering your file, or click the Custom 
button to create a new template. 

c.	 Select the Render loop region only check box if you want to use only a 
portion of your project. If the check box is cleared, the entire project will be 
rendered and saved to the Video CD. 

d.	 Select the Stretch video to fill output frame check box if you want your 
video to be reformatted so it fills the output frame size listed in the 
Description box. When the check box is cleared, the current aspect ratio is 
maintained and black borders are added to fill the extra frame area 
(letterbox). This option is useful when the desired output format does not 
match the frame aspect ratio of you project. 

•	 If you want to use an already-rendered MPEG file, select the Use an existing file 
radio button, and enter the path to the file in the File path box (or click the 
Browse button to locate the file). 

8.	 Click OK. 

Burn it to CD-ROM 

1.	 Select the Burn it to a DVD, Blu-ray Disc, or CD radio button, and then click the 
Next button. The Burn a Disc page appears. 

2.	 Choose the Video CD or CD-ROM with a movie file radio button and click Next. 
The Burn Video CD dialog appears. 

3.	 From the Burn drive drop-down list, use the CD drive that you want to use to burn 
your multimedia CD. 

4.	 From the Burn speed drop-down list, choose the speed at which you want to burn. 
Max will use your drive’s fastest possible speed; decrease the setting to prevent the 
possibility of buffer underruns. 
54 | SAVING AND RENDERING PROJECTS 



VegasQSG.book  Page 55  Monday, June 16, 2008  10:11 AM
5. Select your burning options: 

Option Description 
Buffer Select this check box if your CD recorder supports buffer underrun 
underrun protection. Buffer underrun protection allows a CD recorder to stop and 
protection resume burning. 

Note: Buffer underrun protection can create a disc that can be played in CD 
players, but may contain a bit error where burning stopped and restarted. 
Consider clearing this check box when creating a premaster disc. 

Automatically If you’re burning to rewritable media, select this check box to erase the disc 
erase before burning. 
rewritable 
discs 
Eject when Select this check box to eject the CD automatically when burning has 
done completed. 

6.	 Select the Eject when done check box if you want the CD to eject automatically 
when burning has completed. 

7.	 Choose a radio button in the Burn mode area: 

Option Description 
Burn CDs Begins recording the media file to your CD immediately. 
Test first, then Performs a test to determine whether your file can be written to the CD 
burn CDs recorder without encountering buffer underruns. The file is not recorded to 

the CD during the test, and recording begins after the test if it is successful. 
Test only (do Performs a test to determine whether your file can be written to the CD 
not burn CDs) recorder without encountering buffer underruns. The file is not recorded to 

the CD. 

8.	 Choose the movie file you want to use: 

•	 If you want to render the current project, select the Render format radio 
button. 

a.	 Edit the contents of the File path box to specify the name and location of 
your rendered file. 

b.	 Choose a template from the Template drop-down list to specify the 
parameters that should be used for rendering your file, or click the Custom 
button to create a new template. 

c.	 Select the Render loop region only check box if you want to use only a 
portion of your project. If the check box is cleared, the entire project will be 
rendered and saved to the multimedia CD. 

d.	 Select the Stretch video to fill output frame check box if you want your 
video to be reformatted so it fills the output frame size listed in the 
Description box. When the check box is cleared, the current aspect ratio is 
maintained and black borders are added to fill the extra frame area 
(letterbox). This option is useful when the desired output format does not 
match the frame aspect ratio of you project. 
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•	 If you want to use an already-rendered MPEG file, select the Use an existing file 
radio button, and enter the path to the file in the File path box (or click the 
Browse button to locate the file). 

9.	 Select the Play movie inside Web page check box if you want to create an HTML 
file that will automatically play your movie when the CD is inserted. 

10. Select the Include movie player installer check box if you want to include movie 
player software with your CD. Click the Browse button to locate the movie player's 
installation program. 

11. Click OK. 

12. Your movie is recorded to the CD. When recording is finished, you can select the 
Save movie file check box to keep the MPEG file that was rendered, or you can 
clear the check box to delete the file. 

13. Click Finish. 

Upload it to ACIDplanet 

1.	 Select the Upload it to the Web radio button, and then click the Next button. The 
Upload to the Web page is displayed. 

2.	 Select the ACIDplanet radio button and click the Next button. 

Note: If you haven’t set up a publishing account, the Publish Setup dialog appears.


3.	 Choose the file you want to publish: 

•	 Select the Publish your current project radio button and choose a media 
format from the drop-down list to save the current project in a streaming 
format and publish it to ACIDplanet. 

•	 Select the Publish a different media file radio button and click the Browse 
button to publish a file that you have already rendered to a streaming format. 

4.	 Click the Next button. The Publish Wizard will render your media in the appropriate 
format if necessary. 

5.	 After your file has been rendered, a page from your publishing provider is 
displayed. Follow any instructions on the page and enter information about your 
media file. 

6.	 Click the Next button to upload your media to ACIDplanet. 
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Upload it to YouTube 

Note: You must have a YouTube account created before uploading your movie 

from Vegas Movie Studio. If you do not have an account, go to http://

www.youtube.com/ to create one.


1.	 Select the Upload it to the Web radio button, and then click the Next button. The 
Upload to YouTube dialog appears. 

2.	 Type your YouTube username and password in the YouTube username and 
YouTube password boxes. You can also sign in to YouTube using your Google 
account. 

3.	 Type a name, description, and tags for your video. If you entered a title and 
comments for your project on the Summary tab of the Project Properties dialog, 
they are used here by default for the name and description of your video. 

4.	 Choose a category for your video from the Video Category drop-down list. 

5.	 Choose whether your video should be broadcast publicly or privately. 

6.	 Choose a render quality: Normal or Higher. 

7.	 If you have defined a loop region in your project, you can choose to upload only 
that loop region to YouTube by selecting the Render and upload loop region only 
check box. 

8.	 When you have completed all items on the dialog, click the Upload button to start 
rendering your movie and uploading it to YouTube. This button is not available 
until all items have been completed. 

Save it to Sony PSP media 

1.	 Select the Save it to my camera or portable device radio button and click Next. 
The Save to Camera or Portable Device page appears. 

2.	 Select the PSP™ (PlayStation®Portable) radio button and click Next. The PSP 
Render Settings page appears. 

3.	 Choose File path, Format, Template, and other settings to further customize the 
rendering process, and then click Next to render the movie. 

4.	 The project will begin to render and transfer to your Sony PSP™ 
(PlayStation®Portable). When it’s complete, click Finish to close the Make Movie 
Wizard. 

Save it to your DV camera 

1.	 Select the Save it to my camera or portable device radio button and click Next. 
The Save to Camera or Portable Device page appears. 

2.	 Select the DV camera radio button and click Next. 
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3.	 In the Conform Timeline to Device Format dialog, choose a format in the Template 
field and click Next. 

4.	 In the Leader and Trailer dialog, complete the Leader test pattern style, Test 
pattern duration, Leader black duration, and Trailer black duration fields and 
click Next. 

5.	 In the Device Setup dialog, select the appropriate radio button to indicate whether 
the software will have control of your DV recorder. 

6.	 Click Finish. 

Save it to your HDV camera

 This feature is available only in Vegas Movie Studio Platinum. 

1.	 Select the Save it to my camera or portable device radio button and click Next. 
The Save to Camera or Portable Device page appears. 

2.	 Select the HDV camera radio button and Next. 

3.	 In the Device dialog, choose your camera from the Device drop-down list. 

4.	 In the Select Format/File dialog, select either the Render format or Use an existing 
file radio button (enter the path to the file in the File path box or click the Browse 
button to locate the file) to indicate which file you want to print. 

Note: Selecting the Render format radio button allows you to choose settings for 

rendering the current project before printing to tape. The Use an existing file radio

button lets you save an already-rendered file.


5.	 In the Device Control dialog, select one of these radio buttons: 

•	 Manual (no device control) - The device must be manually cued and set to 
record. 

•	 Crash Recording (device must support basic deck control) - Automatically 
starts and stops recording at the current timecode. 

6.	 Click Finish to start rendering (if necessary) and printing your movie to tape. 

E-mail it 

1.	 Select the E-mail it radio button and click Next. 

2.	 Select the Render your project to this format or the Use an existing file radio 
button (enter the path to the file in the File path box or click the Browse button to 
locate the file). 

3.	 Then do the following: 

•	 For current projects, click Next to create the movie file. When rendering is 
complete, your e-mail program starts and creates a new message with your 
movie attached. 
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•	 For existing files, click Next. Your e-mail program starts and creates a new 
message with your movie attached. 

Rendering projects 

Rendering refers to the process of creating a new media file from a Vegas Movie Studio 
project. The project file is not affected (overwritten, deleted, or altered) during the 
rendering process. You may return to the original project to make edits or adjustments 
and render it again. The following table describes the formats available for rendering 
your project: 

Format Name Extension Definition 
ATRAC Audio .aa3, .oma A Sony proprietary audio compression technology. 
Dolby Digital AC-3 Studio .ac3 Format used to render stereo and 5.1 surround audio for 

DVD Architect Studio projects. 
Main Concept AVC/AAC .mp4 Used to render video to Apple iPod® video format. 
Main Concept MPEG-1 .mpg MPEGs files compressed using a lossy audio/video 
and MPEG-2 compression method, can be used with DVD Architect 

software. 
MP3 Audio .mp3 Highly compressed audio file. 
Ogg Vorbis .ogg A patent-free audio encoding and streaming 

technology. 
QuickTime .mov, .qt QuickTime™ standard audio/video format used on 

Macintosh® computers. 
RealMedia .rm RealMedia is a digital sound and video file format that is 

typically used to stream media through the Internet. It is 
a registered trademark of RealNetworks. 

Sony AVC/AAC .mp4 Used for rendering to the PSP® (PlayStation®Portable). 
Sony Perfect Clarity Audio .pca Sony proprietary lossless audio compression format. 
Sony Wave 64 .w64 Sony proprietary Wave64™ audio file that does not have 

a limited file size (unlike Windows WAV files that are 
limited to ~2GB). 

Video for Windows .avi Standard audio/video format used on Microsoft® 
Windows-based computers. 

Wave (Microsoft) .wav Standard audio format used on Microsoft Windows-
based computers. 

Windows Media Audio .wma The Microsoft audio-only format used to create files for 
streaming or downloading via the Web. 

Windows Media Video .wmv The Microsoft standard used for streaming audio and 
video media via the Web. 

Rendering a file 

To create a media file (files containing only audio or video, or both audio and video), 
you render the project into an appropriate media file output. The final output format 
depends on the destination of the new media file. 

1.	 From the Project menu, choose Render As. 
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2.	 In the Render As dialog, choose the appropriate file format from the Save as type 
drop-down list. 

3.	 Choose a template from the Template drop-down list to select the settings that 
will be used for rendering your file, or click the Custom button to create a new 
template. 

4.	 In the File name box, type a name or browse for a destination for your file. 

5.	 Click Save. 

Tip: For an easy way to render and deliver your final movie, try the Make Movie

Wizard found in Vegas Movie Studio and Vegas Movie Studio Platinum software. 

From the Project menu, choose Make Movie. For more information, see Make

Movie Wizard on page 51.
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Chapter 5
 5.1 Surround  

To give your projects a more professional feel, you can create your movies 
with 5.1 surround sound.

 This feature is available only in Vegas Movie Studio Platinum. 

Tip: Vegas Movie Studio Platinum can be used to create 5.1 surround 
audio for DVD Architect Studio Projects. 

New Project Wizard 

You can set the parameters of a new project, including whether the project 
is in stereo or 5.1 surround, by completing each page of the New Project 
Wizard. 

1.	 From the Project menu, choose New. 

2.	 Use the New Project Wizard to set up your project settings. On the 
Audio Format page of the wizard, select the 5.1 surround radio button. 

3. Click Finish to close the wizard and create your new project. 

In 5.1 surround mode, the following tracks are added to the track list: 

The Front track is used for the front-left and ­
right channels. You can use a pan envelope to 
pan between the right and left channels. 

The Center track is used for the center channel. 
No panning is available. 

The LFE track is used for the low-frequency 
effects channel (subwoofer). No panning is 
available. 

The Rear track is used for the rear-left and rear-
right channels. You can use a pan envelope to 
pan between the right and left channels. 

For the Voice, Music, and Sound Effects tracks, 
you can use the surround panner in the track 
header to pan these tracks throughout the 
soundfield. 

In 5.1 surround mode, the Mixer window displays 
faders you can use to adjust the overall levels of 
the front, rear, center, and LFE channels. 
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5.1 surround panning 

After your project is set up for 5.1 surround sound, you can begin panning.


If you have a joystick, you can use it to control surround panning. A force-feedback 

joystick such as the Microsoft® SideWinder® Force Feedback 2 joystick can add a tactile 

element to your editing sessions.


For more information about joysticks, see the online help (from the Vegas Movie Studio 

Help menu and choose Contents and Index). 

Assign tracks to surround channels 

Each track can be assigned to the front, center, LFE, or rear channels, or you can pan a 
track freely within the soundfield. 

Right-click the surround panner in the track header and choose a command from 
the shortcut menu to choose a surround pan mode: 

Mode Function 

Surround Pan Used to pan a track anywhere among the front, center, LFE, or rear 
channels. Drag the orange pan point in the surround panner to 
indicate where the track’s audio should be sent. 

You can use a pan envelope to automate left/right panning (front/rear 
panning cannot be automated). 

Front Only Used for the front-left and front-right channels. You can use a pan 
envelope to pan between the right and left channels. 

Center Only Used for the center channel. No panning is available. 

LFE Only Used for the low-frequency effects channel (subwoofer). No panning is 
available. 

Rear Only Used for the rear-left and rear-right channels. You can use a pan 
envelope to pan between the right and left channels. 

Panning a track 

You can perform surround panning using any of the following methods: 

•	 Assign a track to the front, center, LFE, or rear channels. When a track is assigned to 
a channel, its audio output is sent to the selected channel. For more information, see 
Assign tracks to surround channels on page 62. 

•	 If a track is set to Front, Rear, or Surround Pan mode, you can use a pan envelope 
to adjust left/right panning. Pan envelopes are not used when a track is set to 
Center or LFE mode. 

•	 If a track is not set to Front, Center, LFE, or Rear mode, use the surround panner 
in the track header. 
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Panning a track in Surround Pan mode 

Drag the orange pan point  in the surround panner window to position the sound 
within the soundfield. 

You can drag the orange pan dot to 
any position in the soundfield. The 
Voice track is panned near the center. 

The Music track is panned to the left-
front speaker. 

The Sound Effects track is panned to 
the right-rear speaker. 

Tips: 

•	 Double-click the pan point to reset it to the center listening position. 
•	 Keyboard and mouse shortcuts can help you position the pan point quickly and 

accurately. For more information about keyboard shortcuts, see the online help (from 
the Vegas Movie Studio Help menu, choose Contents and Index). 

Automating panning with envelopes 

If a track is set to Front, Rear, or Surround Pan mode, you can use a pan envelope to 
adjust left/right panning. 

1.	 Select the track you want to pan. 

2.	 From the Insert menu, choose Audio Envelopes, and then choose Pan from the 
submenu. 

3.	 Add points and adjust the envelope set edit panning throughout the track. 

The pan envelope is added to the left/right position of the pan point (front/rear 
panning cannot be automated). 

For example, if a track’s pan point is set to 10% left and the pan envelope point is 
set to 10% right, the sound will be played through the center at the envelope point. 

For more information about adjusting envelopes, see the online help (from the 
Vegas Movie Studio Help menu, and choose Contents and Index). 
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Changing the pan mode 

Right-click the surround panner on a track, choose Pan Type from the shortcut menu, 

and then choose a pan type from the submenu.


For more information about panning modes, see the online help (from the Vegas

Movie Studio Help menu, and choose Contents and Index).
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